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Abstract

Pigmentation is a morphologically simple but highly variable trait that often has adaptive significance. It has served extensively as a model for
understanding the development and evolution of morphological phenotypes. Abdominal pigmentation in Drosophila melanogaster has been
particularly useful, allowing researchers to identify the loci that underlie inter- and intraspecific variations in morphology. Hitherto, however,
D. melanogaster abdominal pigmentation has been largely assayed qualitatively, through scoring, rather than quantitatively, which limits the
forms of statistical analysis that can be applied to pigmentation data. This work describes a new methodology that allows for the quantification
of various aspects of the abdominal pigmentation pattern of adult D. melanogaster. The protocol includes specimen mounting, image capture,
data extraction, and analysis. All the software used for image capture and analysis feature macros written for open-source image analysis. The
advantage of this approach is the ability to precisely measure pigmentation traits using a methodology that is highly reproducible across different
imaging systems. While the technique has been used to measure variation in the tergal pigmentation patterns of adult D. melanogaster, the
methodology is flexible and broadly applicable to pigmentation patterns in myriad different organisms.

Video Link

The video component of this article can be found at https://www.jove.com/video/55732/

Introduction

Pigmentation shows enormous phenotypic variation between species, populations, and individuals, and even within individuals during
ontogeny1,2,3,4,5,6. Although there are myriad studies of pigmentation in a wide variety of animals, pigmentation has perhaps been best
studied in Drosophila melanogaster, where the full power of molecular genetics has been used to elucidate the developmental and
physiological mechanisms that regulate pigmentation and how these mechanisms evolve1,6. Much is known about the genes that regulate
the biochemical synthesis of pigments in D. melanogaster7,8 and the genes that control the temporal and spatial distribution of this
biosynthesis9,10,11,12,13. Furthermore, genetic mapping has identified the genetic loci underlying intra- and interspecific differences in pigmentation
in D. melanogaster14,15,16,17. The relationships between pigmentation and pleiotropic traits, such as behavior18,19 and immunity19,20, have also
been explored, as has the adaptive significance of pigmentation patterns15,21,22. As such, pigmentation in D. melanogaster has emerged as a
powerful yet simple model for the development and evolution of complex phenotypes.

Pigmentation in adult D. melanogaster is characterized by distinct patterns of melanization across the body, particularly on the wings and
dorsal thorax and abdomen. It is the pigmentation of each cuticular plate (tergite) on the dorsal abdomen, however, that has received the most
research attention. There is considerable variation in this pigmentation (Figure 1A-F), because of both genetic17,23 and environmental24,25

factors. The cuticle of an abdominal tergite is made up of anterior and posterior developmental compartments (Figure 1G), each of which can
be further subdivided depending based on pigmentation and ornamentation26. The anterior compartment includes six cuticle types (a1-a6), and
the posterior compartment includes three (p1-p3) (Figure 1G). Of these, the p1, p2, and a1 cuticle are typically folded under the tergite in un-
stretched abdomens so that they are hidden. The reliably visible cuticle is characterized by a band of heavy pigmentation, here referred to as
a "pigment band," comprised of cuticle types a4 (hairy with moderate bristles) and a5 (hairy with large bristles), with the posterior edge of the
band more intensely pigmented than the anterior edge (Figure 1G). Anterior to this band is a region of lightly pigmented hairy cuticle, which has
bristles posteriorly (a3) but not anteriorly (a2). Variation in pigmentation between flies is observed in both the intensity of pigmentation and in
the width of the pigment band. In general, variation is greatest in the most posterior segments (abdominal segments 5, 6, and 7) and is lower in
the more anterior segments (abdominal segments 3 and 4)24. Furthermore, there is a sexual dimorphism in D. melanogaster pigmentation, with
males generally having wholly pigmented fifth and sixth abdominal tergites (Figure 4C).

In most studies of abdominal pigmentation in D. melanogaster, pigmentation has been treated as a categorical or ordinal trait, with the pattern
measured qualitatively27,28,29 or semi-quantitatively on a scale14,15,16,17,24,30,31,32,33,34,35,36,37. These methods inevitably suffer from a lack of
precision, and because they rely on the subjective assessment of pigmentation, it is difficult to compare the data across studies. Several authors
have quantified the spatial dimensions of pigmentation38,39, the intensity of pigmentation of a particular cuticle type23,25,39,40, or the average
intensity of pigmentation across the abdominal tergite as a whole41,42,43. Nevertheless, these quantification methods do not measure both the
intensity and the spatial distribution of abdominal pigmentation simultaneously and therefore do not capture the nuances of how pigmentation
varies across the abdominal tergite. Furthermore, several of these quantification methods38,41,42,43 require the dissection and mounting of the
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abdominal cuticle. This is both time consuming and destroys the sample, making it unavailable for additional morphological analyses. As the
understanding of the development and evolution of abdominal pigmentation deepens, more sophisticated tools to quickly and precisely measure
both the spatial distribution and the intensity of pigmentation will be required.

The overall goal of this method is to utilize digital image analysis to obtain a replicable and more precise measure of the abdominal pigmentation
in D. melanogaster. The methodology includes three stages. First, the adult fly is non-destructively mounted, and a digital image of the dorsal
abdomen is taken. Second, using an ImageJ macro, the user defines an anterior-posterior strip of pixels that extends from the anterior of the a2
cuticle to the posterior of the a5 cuticle (green box, Figure 1G) on both the third and fourth abdominal segments. The average pixel value across
the width of this strip is then extracted along its long axis, generating a profile that captures the spatial distribution and intensity of pigmentation
as it changes from the anterior to the posterior of the tergite. Third, an R script is used to describe the pigmentation profile mathematically using
a cubic spline. The R script then uses the spline and its first and second derivative to extract the width of the a2-a5 cuticle, the width of the
pigment band, and the maximum and minimum levels of pigmentation. The method therefore quantifies both the spatial characteristics and the
depth of abdominal pigmentation.

This methodology quantifies the pigmentation of the third and fourth abdominal tergites, which have been the focus of numerous previous
studies1,15,23,24,25,28,33,39,42, either exclusively or in combination with more posterior tergites. Although less variable than the fifth and sixth
abdominal tergites, the third and fourth tergites are not completely pigmented in males, so this protocol can be applied to both males and
females. Nevertheless, as shown here, the protocol can be used to measure pigmentation in the fifth and sixth abdominal tergites in females.
Furthermore, minor modifications of the scripts used to extract the characteristics of the pigmentation profile should allow for the method to be
used to quantify the variation in pigmentation in a wide variety of other organisms.

Protocol

1. Specimen Mounting

NOTE: Store dead flies in 70% ethanol in water prior to imaging.

1. Pour 10 mL of 1.25% agar dissolved in boiling water in a 60 mm x 15 mm Petri dish and allow it to set.
2. Under a dissecting microscope, use a pair of fine-point forceps to make a ~20 mm ong, 2 mm wide, 1 mm deep groove in the surface of the

gel. Using fine forceps, embed the ventral side of an adult fly in the groove, with the dorsal side of the fly projecting above the gel.
 

NOTE: The looseness of the gel allows for easy repositioning without damaging the specimen. The same groove can be used for multiple
specimens, although it will become dirty, broken-up, and unusable with time. The user can then make another groove in the same gel. Each
plate can be used to image ~200 flies.

3. Completely cover the specimen in 70% ethanol in water to reduce any light reflections from the waxy cuticle and to prevent wing damage
during specimen manipulation.

2. Microscope Setup

NOTE: Images are acquired using a dissecting scope, transmitted light base, digital camera, and gooseneck cold light source attached to a
computer running image acquisition control software. Software instructions are specific to Micro-Manager v1.4.2044, which is an open-source
software that incorporates ImageJ45.

1. Turn on the microscope, digital camera, double gooseneck cold light source, and computer.
2. Run the image capture software to open a Micro-Manager window and an ImageJ window. In the ImageJ window click "Image" >

"Type" > "8-Bit" to set all images as 8-bit. Click "live" in the Micro-Manager window to open a "Snap/Live" window showing a real-
time preview from the camera.

1. Maximize the size of the "Snap/Live" window if necessary. Select "Grayscale" in the pulldown "Display mode" menu in the "Contrast"
tab of the Micro-Manager window.

3. Turn on the cold light source to its maximum intensity and position the tips of each gooseneck to approximately 120 mm from the stage, one
on the left and one on the right.
 

NOTE: Users can also use an annular illuminator, although this may generate a ring of reflected light around the fly abdomen.
4. Manually set the microscope magnification to 60X so that the field of view captures an area approximately 3 mm in diameter on the stage.
5. Place a 2 mm stage micrometer on the stage (switching the background to white if necessary). While looking at the live preview, focus on the

stage micrometer and adjust the exposure in the Micro-Manager window by entering the exposure time in ms in the "Exposure" box.
6. To spatially calibrate the camera, select the "straight line" tool in the ImageJ window and draw a line the length of the stage

micrometer. In the ImageJ window click "Analyze" > "Set Scale" to open the "Set Scale" window, enter the length of the micrometer
in µm in the "Known distance" box, and enter "µm" in the "Unit of length" box.

1. See that the "Set Scale" window then displays the scale in "pixels/µm." Make a note of the scale and click "OK."

7. In the "Snap/Live" window, click "Stop" and then "Snap" to capture an image of the stage micrometer.
8. Save the image as an 8-bit grayscale TIFF to ensure the ability to spatially calibrate the images again if necessary. In the ImageJ window

click "File" > "Save As" > "Tiff…" Specify where to save the file in the file browser, name the file, and click "Save."
9. Switch the stage to black and place a Petri dish holding a fly mounted in agar (steps 1.1-1.2) on the stage.
10. Look through the microscope and position the fly to ensure that the dorsal midline is straight up in order to best view the pigmentation pattern.

Move any wings and appendages to ensure that the view of the abdomen is unobstructed. If the pigmented cuticle (a2-a5) is not visible,
squeeze the abdomen laterally until it is (although the abdomen of flies stored in 70% ethanol in water stretch, so that this is not usually
necessary).
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NOTE: When positioning the fly, the user may need to use a lower magnification (20X). The magnification must be returned to 60X before
proceeding.

11. Manually focus on the dorsal abdomen of the fly. Manually adjust the tips of the light source to minimize the shadows and reflection on the
dorsal abdomen.

12. While looking at the live preview on the computer screen, and using the pixel value histogram in the "Contrast" tab of the Micro-Manager
window, adjust the exposure as described in step 2.4 to maximize the range of pixel values of the preview image.

13. Remove the fly and Petri dish and replace them with an LED (spectral output of 430-660 nm) connected to a voltage meter, centered in the
field of view at the same position as the fly. Use the LED and voltage meter as a light meter46 and record the voltage generated by the light
striking the LED (~125 mV).
 

NOTE: The LED and voltage meter are used to ensure that light levels are constant across multiple imaging sessions within a single
experiment.

14. For the duration of the experiment, do not further change the position or intensity of the light source, the magnification of the microscope, or
the exposure of the camera.

3. Specimen Imaging

1. Place a Petri dish holding a fly mounted in agar (steps 1.1-1.3) on the black microscope stage.Adjust the position of the fly so that the third
and fourth abdominal segments are visible and the dorsal midline is straight up, as described in step 2.9. Ensure that the magnification is at
60x before proceeding.

2. Manually focus the microscope such that the third and fourth dorsal abdominal tergites are in focus. Use the image capture software to
acquire an image as an 8-bit grayscale TIFF, as described in step 2.6.
 

NOTE: The image can be captured in color and subsequently converted to grayscale for analysis.
3. Save the image as "SESH000_sampleID.tiff," as described in step 2.7.

 

NOTE: Here, [SESH] is constant, [000] is the session number and is variable but must be three digits long, and [sampleID] is whatever the
user wishes, although it must not contain any additional underscore (_) characters and must be of a constant length. [sampleID] should
include details of the factors used in the analysis of the pigmentation data (e.g., temperature or lineage), separated by a distinctive non-
alphabetical character, such as a hyphen (-). This allows these factors to be easily parsed out of [sampleID] using standard statistical
software.

4. Remove the Petri dish from the stage and replace the fly with the next specimen. Repeat steps 3.1-3.3 until all the specimens have been
imaged, without further adjusting the lighting levels, magnification, or exposure.

4. Imaging Across Multiple Sessions

1. If images need to be taken over multiple sessions, maintain the light intensity, exposure, and magnification across sessions. At the beginning
of each session, check the spatial calibration of the camera (step 2.4) and the light intensity at the stage (as measured by the LED/voltage
meter, step 2.12).

2. Capture and save an image of the stage micrometer (steps 2.5-2.7) to ensure the ability to spatially calibrate the images again, if necessary.
3. Use at least 15 control specimens and randomly re-image them in each session to allow for the detection and elimination of session effects.

Ensure that duplicate control specimens between sessions have the same [sampleID] but different [SESH000].
 

NOTE: The control specimens are flies collected, stored, and mounted identically to experimental specimens but are re-imaged across
sessions. The precise number of control specimens will depend on the user's experimental setup. See the discussion for further details.

5. Image Analysis

NOTE: Image analysis is conducted in ImageJ45 and uses the "Measurement of Pigmentation.ijm," macro provided as a supplementary file.

1. Place all images to be analyzed in the same folder.
2. Start ImageJ and run the "Measurement of Pigmentation.ijm" macro by clicking "Plugins" > "Macro" > "Run," selecting "Measurement of

Pigmentation.ijm" in the file browser, and clicking "open."
 

NOTE: All subsequent steps are within the macro. Each step is an individual macro command.
3. Note that an "Action Required" dialog box opens, stating "Choose the folder where images are stored." Click "OK" and use the file browser to

select the folder containing the images and then click "choose."
4. Note that an "Action Required" dialog will box open, stating "Choose the folder where you want the data to be stored." Click "OK" and use the

file browser to select the desired folder for saving the pigmentation profiles. Click "choose."
5. Note that a dialog box will open, asking "How many characters in your sample ID?" In the data input box, enter the number of characters in

[SampleID], as specified in step 3.3, and click "OK."
6. Note that a dialog box will open, asking "How wide is your ROI?" In the data input box, enter the pixel width of the anterior-posterior strip

along which the pigmentation profile is to be read (green rectangle, Figure 1G, Figure 2A, and 2A'). Click "OK;" the default is 20 pixels.
 

NOTE: The pigmentation profile is read across a strip of cuticle, rather than a line, to reduce noise due to hairs and bristles. The width of this
strip will depend on the resolution of the image, but it should be ~1/20th of the width of the abdomen, in pixels.

7. Note that the macro will open the image of the first fly, and a dialog box will ask whether to measure the current fly (click "Yes"), to go on to
the next fly (click "No"), or to exit the macro (click "Cancel").

8. Note that a dialog box will open, stating "Define the midline of the dorsal abdomen, from ANTERIOR to POSTERIOR." The "straight line" tool
will already be selected. Draw a line from anterior to posterior to define the midline of the dorsal abdomen. Click "OK;" see Figure 2A and
2A', yellow line.
 

NOTE: This is used to reorient the image so that the dorsal midline lies horizontally across the screen, with the anterior on the left, making the
subsequent steps easier.
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9. Note that a dialog box will open, stating "Define the POSTERIOR edge of Tergite 4 just behind the pigment band." The "straight line" tool will
already be selected. Draw a line from the posterior midline edge to the right-lateral edge, such that the center of the line (marked by a white
square) sits just posteriorly to the posterior edge of the pigment band (cuticle a5). Click "OK;". See Figure 2A and 2A′, magenta line.
 

NOTE: The R script will automatically detect the posterior edge of the pigment band from the pigmentation profile.
10. Note that a dialog box will open, stating "Define the ANTERIOR edge of Tergite 4 at the anterior edge of the pigmented cuticle (a2)." The

"straight line" tool will already be selected. Draw a line from the anterior midline edge to the right-lateral edge, such that the center of the line
(marked by a white square) sits at the anterior edge of the pigmented cuticle (cuticle a2). Click "OK;". See Figure 2A and 2A', cyan line.
 

NOTE: The R script will define this point as the anterior edge of the pigmented cuticle of the tergite. On the image, the macro will show the
region of interest (ROI) along which the pigmentation profile is read (green rectangle, Figure 2A and 2A′, enlarged in Figure 2B and 2B′).
The macro will also open a second window showing the pigmentation profile for the ROI (Figure 2C and 2C′), where the x-axis is the position,
expressed as the number of pixels from the posterior edge of the profile, and the y-axis is the average pixel value at each position.

11. View the plots of the pigmentation profile that will be opened by the macro. If necessary, click "Live" in the profile window to adjust the
position of the ROI so that it does not include any structures (e.g., bristles) that would influence the pigmentation profile. Once the profile is
satisfactory, click "OK."

12. Repeat steps 5.8-5.11 for Tergite 3.
 

NOTE: The macro then exports the pigmentation profiles as two CSV files, each named "SESH000_samplename_TX_profile.csv," where
[SESH000_samplename] is the image name and [TX] is either T3 or T4 for the third and fourth tergites, respectively.

13. Note that the macro opens the next image. Repeat steps 5.7-5.13 until all images have been analyzed.

6. Data Preprocessing, Analysis, and Session Correction

NOTE: All data analysis is conducted in R47 and uses the "Analysis of Pigmentation.R" script provided. Below, "L…" indicates which line(s) of the
script to run for each part of the analysis. See the Supplementary Information for additional details on how the analysis is conducted.

1. Edit the R script to set the working directory (L6) and define the filepath to the folder containing the.csv profiles (L11).
2. Run L13-15 to generate a list of the pigmentation profiles stored in the profile folder.
3. Load and run the "reader" and "addPrimaryKey" functions (L17-41) to read the profiles into a single data frame.
4. Edit the script at L43 to specify the spatial calibration of the images in µm/pixels, as determined in step 2.5.
5. Load and run the "adjustments" function (L46-58) to convert the profile position (x-axis, Figure 2C and 2C′) from pixels-from-posterior-edge-

of-ROI to µm-from-anterior-edge-of-ROI and the profile value (y-axis, Figure 2C and 2C′) from the pixel value (0 = black, 255 = white) to the
pigmentation value (0 = no pigment, 255 = maximum pigment).

6. Load and run the "spline.der.er" function (L60-71) to generate the cubic spline of the pigmentation profiles and its first and second derivatives
(Figure 2D-2F and 2D′-2F′).

7. Load and run the "coord" and "assmbly.coord" functions (L74-163), first to extract the position of the posterior (T3) and anterior (T2) edges
of the pigment band (Figure 2D and 2D′) and the posterior edge of the a2 cuticle (T1, Figure 2D and 2D′), and then to extract the maximum
(Pmax) and minimum (Pmin) pigmentation values, taken at T3 and T1, respectively.
 

NOTE: The anterior edge of the a2 cuticle has already been defined in step 5.9.
8. Optional: Load and run the "chek" function (L165-175) to check whether the "coord" function is correctly identifying positions T1-3 for a

randomly selected pigmentation profile.
9. Load and run the index and metrics functions (L178-193) to generate a data table with the headings "Session," "Sample," "Tergite," "id" (a

concatenation of Sample and Tergite), "Pmax," "Pmin," "Wband"(width of the pigment band, = T3 - T2), and "Wtergite"(width of the pigmented
cuticles a2-a5, = T3).

10. Load and run the "correction" function (L196-234) to generate a data table that corrects Pmax and Pmin for any nuisance factors arising due
to session effects. Use the average increase (or decrease) in Pmax or Pmin from the control specimens re-imaged across temporally adjacent
sessions.

Representative Results

The protocol was used to explore the effect of rearing temperature on abdominal pigmentation. Previous studies have shown that an increase
in developmental temperature results in a decrease in the spread of abdominal pigmentation in several species of Drosophila, including D.
melanogaster30,32. Specifically, in abdominal tergites 3 and 4, the extent of pigmentation (width of the pigment band) decreases from 17 °C to 25
°C and remains the same from 25 °C to 28 °C24,36. These studies scored the extent of pigmentation on a 1-10 scale (0: no pigment band, tergite
completely yellow; 5: pigment band occupies 50% of the tergite; 10: tergite completely dark). To establish whether the quantitative methodology
could capture this phenotypic plasticity, the pigmentation was measured in the third and fourth abdominal tergites of an isogenic line of ostensibly
wildtype female flies, reared from egg to adult at 17 °C (seven flies), 25 °C (nine flies), and 28 °C (nine flies). To determine the effectiveness of
the correction procedure at removing nuisance factors introduced by session effects, the pigmentation of the same flies was re-imaged and re-
measured one, two, four, and eight days later. Lighting conditions and exposure between sessions were, however, purposely changed to ensure
that there were session effects for the correction procedure to remove. The images have been posted on the Dryad digital repository.

The first question posed was whether there were systematic differences in pigmentation measures across sessions. This was examined using
the lme4 package in R48 to fit the mixed models Mijk = Si + Aj+ εijk and Mij = Aj+ εij to both Pmax and Pmin, where M is the pigment measure, S is
the session (random effect), A is the abdominal tergite being measured (random effect), and ε is the residual error (subscripts are levels within
variables). A log-likelihood ratio test was used to test whether the inclusion of session as a random factor significantly improved the fit; it did
(Table 1). As expected, the examination of the variance components (generated through REML48) indicated that variation due to session effects
accounted for 67% and 70% of the total variance in Pmax and Pmin, respectively (Table 1).
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Fifteen randomly selected control tergites (either third or fourth, from flies reared at 17 °C, 25 °C, or 28 °C) were selected, and changes in their
mean Pmax and Pmin were used to correct the pigmentation measures of the remaining tergites across sessions. Repeating the analysis on the
corrected pigmentation measures eliminated the session effects (Table 1) and reduced the percentage of total variance due to session effects to
zero. The residual error is an estimate, a measurement error after the session effects have been removed, and was 22% and 27% for Pmaxand
Pmin, respectively (Table 1)

Next, the corrected data was used to determine whether the effect of temperature on different aspects of pigmentation and size could be
detected. The mixed model Mijkm= Ti* Dj+ Xk+ εijkm was fitted to the data, where T is the temperature, D is the tergite (third or fourth), and X is the
individual fly (random factor). Because the relationship between pigmentation and temperature is not linear24,36, T was treated as a categorical
factor. The maximum and minimum levels of pigmentation (Pmax and Pmin) and the width of the pigment band and of the tergite (Wband and
Wtergite) were tested. The effect of temperature on the relative width of the pigment band (Rband =Wband/Wtergite) was also tested. The data showed
that the absolute(Wband) and relative (Rband) width of the pigment band decreased from 17 °C to 25 °C (Tukey post-hoc test, P <0.05 for all) and
did not significantly change from 25 °C to 28 °C (Tukey post-hoc test, P >0.05 for all) (Table 2, Figure 3A and 3B), which is consistent with
previous studies24,36. The same pattern was observed for the maximum and minimum level of pigmentation, Pmax and Pmin (Table 2, Figure
3C). The effect of temperature on the level of pigmentation has not been described before, but it initially appears consistent with other studies
that show that the minimum level of pigmentation in the fourth abdominal tergite is positively correlated with the width of the pigment band in
wildtype populations39. However, whilst the data from this study indicate a positive relationship between Pmax and Wband, they show a negative
relationship between Pmin and Wband (Table 3). This difference between the current and previous studies may reflect differences in how genetic
and environmental factors impact the correlation between the level and extent of abdominal pigmentation. Nevertheless, these representative
results show that the protocol is capable of not only identifying patterns of pigmentation previously established through qualitative methodologies,
but also of revealing new ones that qualitative methodologies are not able to detect.

The effect of temperature on the width of the tergite was more complex. In D. melanogaster, body and organ size decline non-linearly with
temperature49. Previous studies suggest that the width of the fifth abdominal tergite decreases by 10% from 16.5 °C to 25 °C, and a further
4% from 25 °C to 29 °C50. While there was a non-significant decrease in the width of the fourth abdominal tergite from 17 °C to 25 °C, both the
third and fourth abdominal tergites increased in width from 25 °C to 28 °C (Table 2, Figure 3D). Since the width of the abdominal tergites is
essentially defined by the user (steps 5.9-5.10 in the protocol), the disparity between the current and previous studies is unlikely to be due to the
way the R script extracts Wtergite from the pigmentation profile. Rather, it may reflect differences in the manner in which the abdominal segment is
measured, in the genotypes of the flies, and in the precise aspects of the abdominal tergites being measured.

The next question posed was whether the methodology could generate data comparable to data collected using existing assessments of
pigmentation. These methods typically ask the observer to subjectively assign each fly to one of a finite number of phenotypic classes based
on the extent of pigmentation15,30,32,33,34 and therefore rely on the observer's ability to assess the width of the pigment band. To test how well
this objective method compares to subjective methods, five observers were asked to rank 45 images of female abdomens based on the width
of the pigment band of the fourth abdominal tergite. The average ranking across observers was compared with the ranking based on Wband, as
measured using this methodology. There was a strong correlation between the subjective and objective rankings (Supplementary Figure 1, in
Supplementary Information.pdf), Spearmen's = 0.7342, P <0.0001).

Another question posed was how this method to extract Wband from the pigmentation spline compared to measuring the width of the pigment
band by hand (visual method) using the linear measurement tool in ImageJ. Again, a strong correlation was found between data collected using
the two methodologies (Supplementary Figure 2, in Supplementary Information.pdf, OLS, r2 = 0.49, P <0.0001). Although the computational
method consistently measured the pigment band as being narrower than in the "visual" method, the regression coefficient was not significantly
different than 1 (P >0.05).

The final question posed was whether this methodology could be used to measure abdominal pigmentation in other contexts. The methodology
could extract the Pmax, Pmin, Wband, and Wtergite for the fifth and sixth abdominal tergites in females and the third and fourth abdominal tergites
in males (Figure 4). Furthermore, the methodology could be used to quantify the increase in Pmaxand Pmin in flies mutant for ebony (e1), which
show an increase in cuticular pigmentation across the body and a specific increase in pigmentation of the cuticle anterior to the pigment band28

(Figure 4).
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Figure 1: Abdominal pigmentation in D. melanogaster. (A-F) Variation in abdominal pigmentation in females of two genotypes reared at
three temperatures (17 °C, 25 °C, and 28 °C). A3 and A4 are the third and fourth abdominal tergites, respectively. (G) The dorsal abdominal
tergite includes an anterior and posterior compartment, only parts of which are reliably visible in un-stretched abdomens. The compartments
are further subdivided into distinct cuticle types: a1: un-pigmented, no hairs; a2: lightly pigmented and hairs; a3: lightly pigmented, hairs, and
moderate bristle; a4: darkly pigmented, hairs, and moderate bristle; a5: darkly pigmented, hairs, and large bristle; a6: un-pigmented and hairs;
p3: un-pigmented and hairs; p2: un-pigmented and no hairs; and p1: un-pigmented and tessellated. The pigment band is made up of cuticles a4
and a5. Only pigmented cuticles (a2-a5, green box) are used in the analysis. Scale bars = 200 µm in (A-F). The contrast of all images has been
adjusted to highlight the pigmentation pattern, and the images are illustrative. Unadjusted images used to generate the representative results are
deposited on the Dryad digital repository. Please click here to view a larger version of this figure.
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Figure 2: Image and data analysis for quantifying abdominal pigmentation. (A-F) and (A-F) are for different specimens and show how the
analysis deals with images of different quality. (A) The user first defines the midline of the abdomen (yellow line), the anterior edge of the tergite
(cyan line), and a line slightly posterior to the posterior edge of the pigment band (magenta line). The ImageJ macro then draws a line from the
midpoint of the anterior and posterior lines (white dashed line), which it widens to form an ROI (black box), magnified in (B). (C) The ImageJ
macro then extracts the average pixel value along the anterior-posterior axis of the ROI. Note that at this stage, the profile is read from posterior
to anterior. (D-E) The R macro converts the average pixel values to a pigmentation value, reverses the direction of the pigmentation profile, fits
it with a cubic spline (S(x)) (D), and calculates the first (S(x)) (E) and second (S(x)) derivative of the spline (F). The script then identifies: T3, the
position of maximum pigmentation, where S(x) transitions from <0 to >0, moving anteriorly from the posterior of the spline; T2, the position where
the decline in pigmentation is the greatest and S(x) is maximum; and T1, the position where the tergite pigmentation is at its minimum and S(x)
transitions from >0 to <0, moving anteriorly from T2,. The anterior of the reliably visible tergite (anterior of cuticle a2) is defined by the user. (A-F)
In cases where the first derivative cannot be used to find T1, typically because S(x) does not cross 0 anteriorly to the pigment band, the script will
define T1 as the position where S(x) transitions from >0 to <0 when moving anteriorly from T2. Please click here to view a larger version of this
figure.
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Figure 3: The effect of temperature on different aspects of abdominal pigmentation in female D. melanogaster. (A) Width of the pigment
band (Wband, Figure 1). (B) Pigment band as a proportion of tergite (Rband). (C) Maximum (Pmax, upper lines) and minimum (Pmin, lower lines)
pigmentation. (D) Width of tergite (Wtergite). The points are least square means from linear mixed-effect models (Table 2). The error bars
represent the standard error and may be obscured by the markers. The black line is third abdominal tergite. The gray line is the fourth abdominal
tergite. Please click here to view a larger version of this figure.
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Figure 4: Differences in pigmentation between the third and fourth abdominal tergites. This is shown in (A) ebony1 females, (B) wildtype
females, (C) wildtype males, and the fifth and sixth abdominal tergites in wildtype females. (D) Maximum pigmentation, Pmax. (E) Minimum
pigmentation, Pmin. (F) Width of the pigment band, Wband. (G) Relative width of the pigment band, Rband. Bars with different letters are significantly
different (Tukey HSD post-hoc test, P <0.05). N = 6 for all except ebony1, where N = 4. Scale bars = 200 µm in (A-C). The error bars represent
the standard error. The contrast of all images has been adjusted to highlight the pigmentation pattern, and the images are illustrative. Please
click here to view a larger version of this figure.

Model Comparison Variance Components (% of total)

Pigmentation
Trait

Model df Log-likelihood X²  (%)  (%)  (%)

Mij = Ai + εij 3 -678.28 1.94 (14%) 11.86 (86%)Pmax
Uncorrected Mijk = Si + Aj +

εijk

4 -457.95 440.66*** 4.08 (26%) 10.71 (67%) 1.14 (7%)

Mij = Ai + εij 3 -875.03 6.05 (9%) 59.39 (91%)Pmin Uncorrected

Mijk = Si + Aj +
εijk

4 -664.58 420.91*** 16.67 (22%) 53.08 (70%) 6.31 (8%)

Mij = Ai + εij 3 -445.05 4.08 (78%) 1.15 (22%)Pmax Corrected

Mijk = Si + Aj +
εijk

4 -444.88 0.3378 4.08 (78%) 0.01 (<1%) 1.14 (22%)

Mij = Ai + εij 3 -649.9 16.67 (73%) 6.24 (27%)Pmin Corrected

Mijk = Si + Aj +
εijk

4 -649.9 0 16.67 (73%) 0 6.31 (27%)

Table 1: Linear mixed-effect models of the effect of tergite and session. Linear mixed-effect models of the effect of tergite and session on
abdominal pigmentation (Pmax and Pmin) of 50 tergites re-measured across five sessions, with variance components estimated through REML.
Models were linear mixed-effect models. M: Pigmentation measure; A: Individual tergite measured; S: Session; ε: Residual error. Significant X²
are shown in bold. * p <0.05. ** p <0.01. *** p <0.001.
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Trait Temperature Tergite Temperature 
 

x Tergite

Pmax F-ratio 8.14 55.59 6.6

P 0.002 <0.001 0.002

Pmin F-ratio 4.41 66.11 6.36

P 0.026 <0.001 0.002

Wband F-ratio 113.93 0.01 0.64

P <0.001 0.931 0.531

Wtergite F-ratio 1.79 0.92 5.11

P 0.191 0.338 0.007

Rband F-ratio 27.66 0.08 1.46

P <0.001 0.782 0.23

Table 2: Effect of temperature and tergite identity. The effect of temperature and tergite identity on different aspects of abdominal
pigmentation in 50 tergites re-measured across five sessions. Models were linear mixed-effect models, with individual fly included as a random
factor. Pmax: Maximum pigmentation (corrected); Pmin: Minimum pigmentation (corrected); Wband: Width of pigment band; Wtergite: Width of tergite;
Rband: Relative width of pigment band. Significant fixed factors are shown in bold (P <0.05).

Intercept Wband Temperature Tergite

17˚C 25˚C Third

Pmax β 234.35 0.069 0.063 -1.178 -0.588

F 29.93 5.97 54.82

P <0.001 0.008 <0.001

Pmin β 223.96 -0.137 3.931 -3.024 -1.54

F 19.33 9.66 62.02

P <0.001 0.001 <0.001

Table 3: Effect of pigment band width, temperature, and tergite identity on the level of pigmentation. Effect of pigment band width,
temperature, and tergite identity on the level of pigmentation in 50 tergites re-measured across five sessions. Models were linear mixed-effect
models, with individual fly included as a random factor. Pmax: Maximum pigmentation (corrected); Pmin: Minimum pigmentation (corrected); Wband:
Width of pigment band; Rband: Relative width of pigment band.

Supplemental File 1. Supplementaly Information. Please click here to download this file.

Supplemental File 2. Analysis of Pigmentation.R script. Please click here to download this file.

Supplemental File 3. Measurement of Pigmentation.ijm Please click here to download this file.

Simulation R Script. Please click here to download this file.

Discussion

This methodology allows for the precise, rapid, and repeatable acquisition of pigmentation data in a quantitative form suitable for multiple
downstream analyses. The method has been used to acquire data on the effect of temperature on abdominal pigmentation in an isogenic line
of flies. However, the methodology could be used in forward-genetics studies to identify genes that underlie pigmentation differences between
individuals, populations, or species, or reverse-genetic studies to explore the effects of specific genes on pigmentation patterns. Although, as
discussed above, there have been myriad studies that have explored the development and evolution of D. melanogaster pigmentation, the
precision with which this methodology captures pigmentation data in a quantitative form allows for more powerful statistical approaches. This
in turn allows researchers to use fewer samples when analyzing pigmentation patterns, or allows them to elucidate more subtle aspects of
pigmentation. Furthermore, this method does not require the dissection of the fly, allowing the sample to be subsequently used for additional
analyses, such as morphological measurements or genotyping. Indeed, the methodology could potentially be used on anesthetized flies, which
could then be selectively bred based on their pigmentation characteristics.

One potential issue with measuring pigmentation through image analysis is that the pigmentation values may reflect the exposure and lighting
conditions under which an image was taken, rather than the level of pigmentation itself. While using fixed lighting levels, light positions,
magnification, and exposure helps to alleviate these issues, it is likely that it will still be necessary to take several repeat control images in each
session to fully control for session effects. This method includes re-imaging fifteen control specimens each session and using the between-
session changes in Pmax and Pmin to detect and eliminate session effects. However, the precise number of control specimens that should be re-
imaged will depend on the imaging hardware and software being used, the aspect of pigmentation of interest to the user and how variable it is
between treatments, and how many images are taken in each session. Conducting a preliminary experiment in which the same specimens are
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re-imaged over five sessions will allow the user to calculate the variance due to session effects, the variance due to specimen identity, and the
residual variance (which is an estimate of measurement error after correcting for session effects) (Table 1). These values can then be used to
estimate how many control images need to be taken in each session to detect and control for session effects. A simple R script has been written
and uses data from such a preliminary experiment to simulate pigmentation measures across sessions. It can be used to check that the number
of control images per session are sufficient to remove the session effects. This script is provided as a supplementary file.

If users are concerned that there are nuisance factors within sessions, they can also reimage the same specimen multiple times throughout the
session, as described in John et al., 201641. In this case, [sampleID] for the single control specimen must be changed each time it is re-imaged
within a session (e.g., control1, control2, control3, etc.); otherwise, the imaging software will replace the previous image with the new image
of the same name. The correction function bases its correction on duplicate images with the same [sampleID] between temporally adjacent
sessions and will correct, whether the same specimen is re-imaged multiple times within and between sessions or whether the same set of
control specimens are imaged between sessions. Regardless of how the control images are taken, sessions should be treated as blocks, and
where possible, users should employ a randomized block design so that any session effects that remain after correction can be statistically
controlled for. Failing this, specimens should be randomly assigned to sessions so that session effects are not confounded with experimental
factors.

The protocol relies on the generation of a pigmentation profile that represents the change in pigmentation across each tergite. One issue with
generating this profile is the dark hairs that cover the abdominal cuticle, which are invariably bisected by any anterior-posterior line that crosses
the tergite. The protocol reduces the noise generated by these hairs by taking the pigmentation profile averaged across a band of cuticle.
Nevertheless, users may set the width of the ROI to 1 pixel in step 5.6 if they wish to generate profiles that are based on a thin line of cuticle.
Furthermore, users may analyze the same image multiple times, changing the lateral position of the pigmentation profile to capture changes in
the width of the pigment band within a segment. In this case, however, users would need to copy the same image multiple times and give each
copy a unique name before conducting step 5.1, since the ImageJ macro will overwrite profiles of the same name.

A second important consideration when generating the pigmentation profile is the smoothing parameter of the cubic spline, defined within the
spline.der.er function (L63) in the Analysis of Pigmentation R script. The appropriate smoothing parameter depends on the imaging setup and
resolution. Over-smoothing a profile can result in a loss of the characteristics of the spline profile used to calculate the coordinates of T1, T2,
and T3 (Figure 2D and 2D'). Conversely, under-smoothing increases the noise of the profile and consequently the accuracy of the coordinate
extractions. The chek function produces a graphical summary of the spline and its derivatives and can be used as a visual cue to choose an
appropriate smoothing parameter.

The methodology described here focuses on capturing data on the pigmentation of the third and fourth abdominal tergites in female and male D.
melanogaster. However, the representative results indicate that it can also be used to measure the pigmentation of the fifth and sixth abdominal
segments of females. Furthermore, the methodology can detect differences in phenotype caused by mutants of genes that affect pigmentation.
The ImageJ macro and R scripts can easily be modified to measure pigmentation in the abdomens of different D. melanogaster species, or even
pigmentation of other body parts in other taxa, provided that the pigmentation pattern is stereotypical. Finally, the methodology could also be
adapted to measure aspects of pigmentation color by capturing images in RGB and analyzing each channel separately.

In general, this methodology is part of the emerging field of phenomics51,52. The goal of phenomics is to generate and analyze large multi-
dimensional phenotypic datasets to better understand the genetic and environmental interactions that influence phenotype, including disease,
and how these interactions evolve to generate biological diversity. For phenomics to fulfill its potential, however, methodologies for acquiring
phenotypic data must be straightforward and easily adapted to different phenotypes, as well as freely available. By using open-source software
to analyze images captured using standard equipment, this methodology helps to achieve this goal.
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